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INTRODUCTION

The Cal/Config software application for mARK2™ enables
the calibration and configuration of Gennum Digital hearing
instruments.

The software uses a set of software building blocks called
The Manufacturers' Application Resource Kit™ or
mARK2™. These building blocks work "behind the scenes"
to perform device calibration at final test using standard
test equipment.

Fig. 1   Typical Test Equipment Configuration

Figure 1 shows a typical connection of the test equipment
at final test. The fully completed shell of the hearing
instrument is coupled to the Frye measurement microphone
in the usual manner with a 2cc coupler and connected to
the programmer with an appropriate programming cable.
Although this procedure can be adapted to work with any
test equipment, it has been developed to work primarily
with the following standard equipment:

• Frye FONIX 6500 Hearing Instrument Test System
equipped with the RS232 interface (earliest tested
release of Frye firmware is ver. 4.21E)

• Interacoustics TBS25 (or similar B&K model) anechoic
test chamber

• Programming box (eg. HiPro, Microcard, Gennum DSP
programmer)

• PC running Windows 95/98/2000/NT/XP

The Interacoustics chamber is recommended over the Frye
chamber as it provides better acoustic isolation. However,
as long as an adequate signal-to-noise ratio is obtained,
any test box will suffice. A minimum of 40dB SNR is
required to obtain a 0.1dB accuracy.

SOFTWARE INSTALLATION

Upon installing ARKbase™, a shortcut to Cal/Config2 is
created under the Manufacturing Tools folder (all folders
discussed here are sub folders of the Gennum folder under
the Start Menu). The Frye FONIX 6500 Configuration Tool,
Workstation Manager, and mARK Conversion Tool are under
the Configuration Tools folder.

FRYE FONIX 6500 CONFIGURATION TOOL

Before performing calibration and configuration of Gennum
digital hybrids, it is necessary to run the FONIX 6500
Configuration Tool so that the Cal/Config software
application will know which COM port to use for
communication with the FONIX 6500 and what timeout
value to use when communication occurs; otherwise, a
communication failure will occur. The default value for the
timeout is one second and it is recommended that this
value be used unless communication errors occur. 

The COM port can be found by clicking the Start Menu,
Settings, and Control Pannel. Choose the System icon and
change to the Device Manager tab. Here, under Ports
(COM & LPT) the available COM ports can be checked.
The COM port can be an integer value from 1 to 15 and the
timeout must be a positive value in milliseconds.

Fig. 2   Frye FONIX 6500 Configuration Tool
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WORKSTATION MANAGER

The Workstation Manager is a software application that sets
any workstation specific options. It is designed to replace
the Options form in previous versions of Cal/Config. 

To set up the default settings for a workstation:

1. Open the Workstation Manager.

2. Fill in the settings for the various workstation related
options or click "Open File" to open and edit an existing
.wrk file.

3. Click "Save Settings" to save all settings to a .wrk file.

4. Click "Exit" to close the program.

The options available in the Workstation Manager are:

• Stimulus and Measurement device 

• Programmer

• The default ear to communicate through

• Verify if burn operations were successful

• Display calibration results to the operator in the
instructions window of Cal/Config

• The configuration directory where Cal/Config will search
for .ids files 

• Show background which displays the splash
background

• A log file, which must be specified with a path, to store
the calibration results

• Report Errors to Operator. This can only be disabled if
logging to file is chosen.

• Max Noise Level which is the maximum noise measure
allowed before each calibration step takes place

• The stimulus level. This is a composite signal which is
applied by the stimulus device after calibration

The .wrk created in the Workstation Manager is then
referenced in Cal/Config using the /WorkFile command line
parameter (see the Cal/Config Command Line Parameters
section for further details). To avoid using a command line
parameter to access the .wrk file, save the file in the same
directory as CalConfig2.exe as “worksetup.wrk”.

Fig. 3   Workstation Manager

CAL/CONFIG AND IDS

Setting up the calibration parameters was done in the
Engineering Mode in previous versions of Cal/Config. To
increase the simplicity of the Cal/Config software
application, setting up calibration parameters has been
relocated to IDS. Only the .ids file needs to be created to
perform calibration and configuration on Gennum digital
hybrids. The IDS also contains a scratch editor so that the
scratch data can be edited and saved to the configuration
file.

CALIBRATION SETUP IN IDS

The calibration setup section can be opened from
Cal/Config -> Setup… on the menu. Selecting this menu
item will open a new form with a series of tabs
corresponding to the calibration options available for the
selected product. For instance, a PARAGON product will
have directional calibration options available while a
FOUNDATION product will have trimmer calibration options
available. Once all of the options are selected in the
calibration setup, press OK and save the .ids file. The
calibration setup options will be included in the saved .ids
file.

General

All products will have a general calibration tab. This tab
allows for the set up of general options for a product
configuration. 

The general options will include:

• Configure scratch area (See the Scratch Editor section)

• Use serial number as the first four bytes of the scratch
area. This is entered in the serial number box in
Cal/Config and will overwrite the first four bytes stored in
the scratch editor.
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• Use control parameter values from Memory
Configuration which brings in the control data from the
.ids file, if it exists, and burns it into the hearing
instrument during the configuration process of
Cal/Config.

• Set the active memory after the calibration process

• The configuration type. The value entered should
correspond to a value in the "Select Calibration Type"
combo box in Cal/Config so this file will appear in the
"Select Configuration" combo box when that option is
selected in the "Select Calibration Type". 

NOTE: Calibration types can be defined in the
ConfigFile.txt file located in the root directory where
ARK was installed. The default configuration types are
BTE, ITE, ITC, CIC.

• Static or momentary memory select 

Fig. 4   General Calibration Setup

Sensitivity

The sensitivity calibration setup options determine how to
perform calibration of the input and output transducers. The
sensitivity options include:

• Input type which selects the input transducer to be used
for the sensitivity calibration.

• The source frequency to use when calibrating the
transducers (specified in Hz)

• The receiver correction factor. This is specified in dB
and will be subtracted from the receiver sensitivity when
calibration is performed.

• The input and output sensitivity ranges. If the sensitivity
measured falls outside of the respective transducer
range, an error will be reported and the calibration
process will stop.

Fig. 5   Sensitivity Calibration Setup

Volume Control

The volume control calibration setup determines whether or
not to calibrate the external volume control. Selecting the
calibrate volume control check box will calibrate the volume
control. For FOUNDATION products, the choice can be
made to use two terminal or three terminal volume controls.
For PARAGON products, this option is not available.

Fig. 6   Volume Control Calibration Setup
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Telecoil

The telecoil calibration setup determines how to perform
calibration of the telecoil. 

The telecoil options include:

• Calibration of the telecoil. All other options on this tab
become enabled once this is checked.

• Prompt for repositioning of the telecoil during
calibration. This is because some anechoic test boxes,
such as the interacoustics box, have their magnetic coil
located along the side of the box rather than in the
centre where the hearing instrument is initially
positioned for maximum acoustic pickup. 

• The telecoil sensitivity range. If the sensitivity measured
falls outside of the specified range, an error will be
reported and the calibration process will stop.

• Telecoil gain adjustment. This is specified in dB and will
be subtracted from the telecoil sensitivity when
calibration is performed.

NOTE: Calibration of the telecoil can be avoided altogether
by specifying a certain amount of gain to be applied in the
telecoil path. This can be set up through ARKonline™ as a
constant or it can be a slider where the gain can be set
using an application such as the IDS. The gain can be set
anywhere from -10 to 23dB.

Fig. 7   Telecoil Calibration Setup

Directional

The directional calibration setup determines how to perform
FRONTWAVE™ calibration. 

NOTE: This tab is available for PARAGON products and is
removed for FOUNDATION products. 

The directional options include:

• Enabling the calibration of FRONTWAVE™. All other
options on this tab become enabled once this is
checked.

• Specifying the microphone spacing. This is entered in
mm.

• The expected null depth. Enter into this grid the
frequency and reduction pairs. After FRONTWAVE™
calibration takes place, the hearing instrument is
configured into bi-directional mode and the null depth is
measured at the frequencies specified. This value is
compared against the reduction value in the grid for the
corresponding frequency. If the null depth is less than
specified, an error will be reported. 

NOTE: Once a frequency and reduction pair are
entered into the grid, a new row will appear allowing for
more data to be entered.

Fig. 8   Directional Calibration Setup
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Trimmer

The trimmer mode calibration setup determines how to
configure trimmers. 

NOTE: This tab is available for FOUNDATION products and
is removed for PARAGON products. 

The directional options include:

• Enable the calibration of trimmers

• Calibrate trimmers as two terminal or three terminal

• Check trimmer connections after configuration. This is a
check to ensure that the connected trimmers are
functioning properly. The trimmers can be checked at
VREG or GND. Depending on the selection, position the
wiper of the trimmer to the respective position before
calibration and configuration. If the trimmer is not
connected properly or the wiper is not positioned
properly, an error message will be displayed. 

• Secondary verification of trimmers. This option checks
that multiple queries of the trimmer setting return
consistent results. If the trimmer is not consistent, an
error message will be displayed.

Fig. 9   Trimmer Calibration Setup

Acoustic Calibration Bypass

All calibration routines are set by default to be performed
acoustically. This option can be changed in the acoustic
calibration bypass section. It is available from the 
Tools->Acoustic Cal Bypass… menu item on the Calibration
Setup form. 

The options available are:

• Skip acoustic calibration. 

NOTE: The acoustic calibration and bypass mode are
mutually exclusive. That is, only one can be chosen for
a configuration. 

• The microphone sensitivity (in dBV/dBSPL). This value
will be assigned to the part in place of the sensitivity
that would be determined in the acoustic calibration.

• Assume the device's microphone matches the
microphone model. Checking this check box will set the
microphone sensitivity to 0 and this assumes that the
microphone matches the model.

• The receiver sensitivity (in dBSPL/dBV). This value is
similar to that of the microphone.

• Assume the device's receiver matches the receiver
model. This is similar to that of the microphone.

• The telecoil sensitivity (in dBV/dBSPL). This value is
similar to that of the microphone.

• Assume the device's telecoil matches the telecoil
model. Checking this check box will set the telecoil
sensitivity box to 0. The value burned into the part will
be assigned to 20dB less than the sensitivity of the
microphone. 

NOTE: For telecoil calibration, the calibrate telecoil check
box on the telecoil tab must still be checked for telecoil
calibration to take place.

Fig. 10   Acoustic Calibration Bypass
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SCRATCH EDITOR 

The scratch editor can be opened in the IDS from
Cal/Config -> Scratch Editor… on the menu. The scratch
editor will display 128 bytes per page and will show as
many pages as necessary to expose the number of bytes of
scratch information that the chosen product can have. The
information can be entered into the scratch editor in binary,
decimal, hexadecimal, and ASCII. 

Scratch files created for older versions of Cal/Config can be
opened in the editor using the Import .txt Data button.

If a connected device has been initialized in the IDS, the
read and write buttons in the editor will be enabled and the
device's scratch contents can be read into the editor or
burned from the editor by pressing the read and write
buttons respectively. When a connected device's scratch
memory is burned and the "Use Serial No. as first four bytes
of scratch" is selected in the Cal/Config Setup section, the
Serial No. text area will be burned to the part. 

NOTE: The value entered for the Serial No. is only intended
to be used when burning to an attached device. This value
will not be saved to the .ids file.

Once the data has been set in the scratch editor, pressing
OK and saving the IDS configuration to a .ids file will
include the scratch data. Alternately, opening up a .ids file
will fill the scratch editor with the contents of the file.

Fig. 11   Scratch Editor

CAL/CONFIG

Cal/Config has been simplified to contain only what was
referred to as the Production Mode in previous versions of
Cal/Config. 

Fig. 12   Initial View of Cal/Config

MENU ITEMS

The File menu item contains two sub-menu items. Refresh
Files and Exit. The Refresh Files option refreshes the Select
Configuration combo box with the contents of the
configuration directory. This is because files created and
saved in the IDS after Cal/Config is opened will not be
visible until Refresh Files is pressed. 

The Ear and Programmer menu items select the ear and
programmer. The ear and programmer are initially set to
their respective values from the selected .wrk file (see
Cal/Config Command Line Parameters). The currently
selected programmer is also displayed in the upper right
hand corner of the Cal/Config form.

The Tools menu item has four sub-menu items: Force Single
Acoustic Cal, Check Calibration, Manual Calibration…,
Reset Factory Defaults. All of these items become available
once a configuration is selected in the Select Configuration
box. 

Pressing Force Single Acoustic Cal will force acoustic
calibration to take place on the next hearing instrument
which is calibrated. This option is reset after the next
calibration process. This has been implemented so that an
.ids file can be set to perform bypass acoustic calibrations
but the operator can still execute an acoustic calibration
with the same file. 

Check Calibration contains sub-items which are relevant to
the device contained within the configuration file in the
Select Configuration box. Pressing one of the check
calibration options will check if the selected option is
calibrated in the connected device. The results will be
returned in a message box. 
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Pressing Manual Calibration… opens a form which
performs manual calibration. In the Manual Calibrate form,
select a calibration element and a series of input
parameters will be displayed for that element. For example,
pressing Input Sensitivity displays Raw Sensitivity in the
Input Parameters box. Enter appropriate values for the input
parameters and press Set after entering each parameter.
Once all the parameters are assigned, press GO. The
calibration element selected will be programmed into the
device. 

Fig. 13   Manual Calibrate

Reset factory defaults will reset all calibration parameters in
the connected hearing instrument. This is useful when
evaluating the benefits of calibration.

PERFORMING CALIBRATION AND CONFIGURATION

Calibration and configuration can be performed with the
following steps:

1. In the Select Configuration Type box, select the
configuration types to be displayed in the Select
Configuration box. Those files which were saved with
their Configuration Type (on the General tab of
Cal/Config in the IDS) matching this selection will be
displayed in the Select Configuration box. The default is
All Configurations.

2. In the Select Configuration box, select the configuration
file to use. 

3. Enter a serial number if Use serial no. as first four bytes
of scratch was selected in the configuration file. The
serial number can range from 0 to 2,147,483,647.

4. Press Go (it will become enabled at this point)

5. If applicable, make sure that the telecoil is pointed
perpendicular to the magnetic field in the anechoic test
box before beginning or when prompted to do so.

6. Pressing cancel at any time during the calibration and
configuration process will cancel the process. Please be
patient with the response of the program returning
control since the system cannot interrupt a single step
mid way through. The system will cancel once the step
is completed.

NOTE: If /TrimDisplay (see the Cal/Config Command Line
Parameters section) is used and a FOUNDATION product is
selected in the Select Configuration box, a series of trimmer
combo boxes will be displayed at the bottom of the form.
These combo boxes will initially be set to the trimmer
assignments defined in the .ids file. The trimmers can be
reassigned by changing the combo box settings before
pressing Go.

Fig. 14   Cal/Config with /TrimDisplay

After each step is completed, a green check mark will
indicate that the step completed successfully. If a step does
not complete successfully, a red X will appear. If the user
has not deselected “Report errors to operator” in the
Workstation Manager, then Cal/Config will stop and display
an error message. Otherwise, it will display the red X but
will continue the calibration and configuration process.
Upon completion, the form will indicate that the process
was successful and the user can begin the process for
another hearing instrument.
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Fig. 15   Successful FOUNDATION Calibration and Configuration

Fig. 16   Unsuccessful PARAGON Calibration and Configuration

CAL/CONFIG COMMAND LINE PARAMETERS

Cal/Config can be run with several command line
parameters to enhance the capabilities of the application.
To use the command line parameters, create a shortcut to
Cal/Config2 on the desktop. Right click on the shortcut and
select properties. Modify the target to add the desired
command line parameter(s). For example, to use the
/TreeStruct command line parameter, set the target to:

"C:\Program Files\Gennum\ARK\CalConfig2.exe" 
/TreeStruct.

NOTE: The command line parameters are not case
sensitive.

The command line parameters available for Cal/Config are:

• /NoLogo — This option removes the Gennum logo from
being displayed on startup.

• /TreeStruct — Enables the tree structure selection setup
for Cal/Config (see the Tree Structure section)

• /SkipMemX — Skips burning memory X where X = B, C,
D. For example, to skip burning memory D use
/SkipMemD.

• /ShowMems — This displays a menu item which allows
an operator to select which Paragon or Duet
memories to skip without having to restart the
application to specify a different set of /SkipMemX
arguments. If the user runs the program with /SkipMemX
arguments, those settings are the defaults that appear
in the menu list. If no /SkipMemX arguments are
included, then no memories will be skipped as default.

• /WorkFile — Causes a dialog box to appear on
Cal/Config startup. Select a .wrk file created in the
Workstation Manager. 

NOTE: This option only needs to be run once since the
application will remember the most recent .wrk file
selected.

• /ForceAcoustic — This forces all calibration routines to
be done acoustically. That is, all acoustic bypass
settings will be ignored and the calibration routine will
instead be done acoustically.

• /TrimDisplay — This option displays the trimmers for
trimmer based FOUNDATION products.

• /QuickConfigureChars=X — The maximum number of
characters to allow in the quick configure box in tree
struct mode. X is the maximum number of characters
that can be entered. For example, to allow a maximum
of five characters to be entered, use
QuickConfigureChars=5.
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TREE STRUCTURE

Cal/Config can be run in default mode or in tree structure
mode. Tree structure mode allows operators to select
configuration files based on defined criteria rather than
selecting the files from a list. The selections chosen  will
point to a configuration file.

Fig. 17   Default Tree Structure

The default tree structure has two selections, Product and
Type, and two options, VC and Telecoil. An operator would
select a product and then, based on the selected product,
a set of types would be displayed in the type box. The
options can be selected as yes or no but depending on the
selections in the Product and Type boxes, these options
may not be applicable and will be disabled. For example,
selecting PARAGON as the product and CIC as the type,
VC and telecoil are disabled. 

Once the selections are chosen, a file will appear in the File
Name box and Go will become enabled. Calibration and
configuration can proceed by pressing Go and the hearing
instrument will be calibrated and configured with the file in
the File Name box. If a configuration is not defined for the
selected setting, a message box will indicate that the
selection is invalid.

Fig. 18   Configuration selected from the tree structure

Tree structure settings can also be chosen with the Quick
Configuration box. Enter text into the Quick Configuration
box and press Enter. If the configuration is recognized, then
the tree structure will be automatically assigned with
associated values defined for the quick configuration. The
default quick configuration definitions are located in the
TreeFileMap.txt file in the root directory where ARK was
installed. Please see the Customizing the Tree Structure
section for more information.

Customizing the Tree Structure

The tree structure layout can be customized to display
different selection options. Customizing the layout is done
by modifying the TreeSelectors.txt file located in the root
directory where ARK was installed. 

There are three characters which, when they appear as the
first character on a line, are interpreted as special
characters. These characters are %, #, and *. The %
indicates that the line is a comment and should be ignored. 

The # character defines a combo box in the tree structure
which appears on the left side of the settings area. These
combo boxes cannot be disabled and when selected, but
will fill the following combo box with certain values when a
selection is made. The value beside the # character
indicates the name which will appear above the combo
box. The following lines will define the values and behaviour
of the combo box until another special character line is
reached. For each of these lines, the first item on the line
defines the value to add to the combo box. The following
tab delimited items on the line define what values in the
following combo box will appear when that item is selected
in the combo box.

Consider the default example:

#Product

PARAGON BTE ITE ITC CIC

FOUNDATION BTE ITE ITC CIC

#Type

BTE

ITE

ITC

CIC

In this example, there are two combo boxes that are
defined, Product and Type. Product has two items:
PARAGON and FOUNDATION. Type has four items: BTE,
ITE, ITC, and CIC. When Cal/Config is run, only the Product
combo box will have values in it and the Type combo box
will be empty until a Product is selected. If PARAGON is
selected, the Type combo box will be will filled with BTE,
ITE, ITC, and CIC.

The * character defines a combo box in the tree structure
which appears on the right side of the settings area. These
combo boxes always have values appear in them but can
be disabled by the combo boxes on the left. 
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NOTE: The * combo boxes can only be defined in the file
after all # combo boxes are defined. The value beside the *
character indicates the name which will appear above the
combo box. The following tab delimited items on the line
define what combinations of the # combo boxes will make
that combo box disabled. The combinations must appear
as "," delimited values. There will be as many values as
there are # combo boxes. If all selections of a # combo box
make the * combo box disabled, the "*" wildcard character
can be used. The following lines will define the values of the
combo box until another special character line is reached.

Consider the default example:

*VC *,CIC

Yes

No

*Telecoil *,CIC

Yes

No

In this example, there are two combo boxes defined, VC
and Telecoil. Both of these combo boxes are made
disabled when any Product  is slecected and the Type is
set to CIC. If this were only true when PARAGON was
selected, the definition would be "PARAGON,CIC". 

NOTE: More than one definition to disable the combo box
can be applied but further definitions must be tab delimited
on the same line. Both of these combo boxes have two
values, Yes and No.

Tree Selection and File Association

Once the tree structure is customized, the selections must
be assigned to associated .ids files. This is done in the
TreeFileMap.txt file located in the root directory where ARK
was installed.

There is one special character which, when it appears as
the first character on a line, is interpreted as a special
character. This character is the % and indicates that the line
is a comment and should be ignored. All other lines define
file associations from selections. The association is defined
by specifying the combo box selections, in the order that
they are defined in the TreeSelectors.txt file and tab
delimited. This is followed by the .ids file to associate and
then the quick configure text. These values are also tab
delimited.

Consider an excerpt from the default example:

PARAGON ITC No No Paragon.ids PAR_ITC

PARAGON CIC - - Paragon.ids PAR_CIC

FOUNDATION BTE Yes Yes Foundation.ids
FOUN_BTE_V_T

In this example, there are three file associations. If Product
is PARAGON, the type is ITC, the VC is No, and the Telecoil
is No, then Paragon.ids is the file which will be used to
configure the hearing instrument. Entering PAR_ITC into the
Quick Configure box in Cal/Config and pressing enter bring
up the defined configuration file. 

In the second definition, the VC and Telecoil are assigned to
"-". This is because these options are disabled in that
configuration. 

NOTE: If a configuration is selected and no file association
is found, a warning message will be displayed indicating
that a file was not found for the given association.

In order to ease in the construction of these files, it is
recommended that a spreadsheet be used to create these
files using different cells for tab delimited values. Then,
save the file as a tab delimited ASCII text file in the names
and locations provided.

mARK CONVERSION TOOL

Since there may be a need to use calibration definitions
from old versions of Cal/Config, the mARK Conversion Tool
will take an old calibration file (.clc), memory configuration
file (.ids) and scratch file (.txt) and convert them into a new
.ids file. 

There are parameters which are now stored in the .ids file
which were previously not saved in the .clc file. These
parameters can be appended into the new .ids file by
selecting them in the Extra Options form. This form is
available from the Tools -> Extra Options… item on the
menu. If these parameters are not changed, the default
values shown will be saved to file. These options must be
selected before converting the .clc file(s).

To convert a single file:

1. Press the convert button in the Single File section.

2. Select a .clc file in the dialog box that appears.

3. Input the new .ids filename to be saved.

To convert a directory of .clc files:

1. Press the Convert All button in the Directory section.

2. Select a directory where the old .clc files are located.

3. Select a directory where the new .ids files should be
created. The new .ids files will have the same names as
the corresponding .clc files, except that they will have
"_new" added to the end of the name.  i.e. example.clc
will become example_new.ids.

4. A prompt will appear if the new file name already exists
in the storage directory.  Select yes to replace the
existing file.
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REVISION NOTES:
Added command line argument /ShowMems.

DOCUMENT IDENTIFICATION
APPLICATION NOTE
The product is in a development phase and specifications are subject to
change without notice. Gennum reserves the right to remove the product
at any time. Listing the product does not constitute an offer for sale.

Fig. 19   mARK Conversion Tool

Fig. 20   mARK Configuration Tool — Extra Options


